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Getting Started

Introduction

Pocket LABEL MATRIX® is an application that allows you to
take labels created in LABEL MATRIX® label design software,
download them to your Windows® CE/Pocket PC device, and
print them using a direct or network/wireless connection.
Pocket LABEL MATRIX supports standard types of label content,
including text, bar codes, graphics and more. Pocket LABEL
MATRIX also allows you to access data from several types of
variable data sources.

This guide is designed to provide you with the basic information
you need to install and activate Pocket LABEL MATRIX,
download labels to your Windows CE/Pocket PC device, use
Pocket LABEL MATRIX to enter or edit variable data, and print
labels using a direct or network/wireless connection.

Usage Requirements

The following software and hardware components are required
in order to use Pocket LABEL MATRIX.

• LABEL MATRIX PowerPro version 7.01 or higher label 
design software (includes one Pocket LABEL MATRIX 
license) installed on the host computer OR LABEL MATRIX  
version 7.01 or higher and a Pocket LABEL MATRIX add-on 
license installed on the host computer

• Supported Windows CE/Pocket PC device

• Microsoft® ActiveSync® synchronization software v3.5 or 
higher (included with all Microsoft Windows powered 
Pocket PCs), installed on the host computer

e
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Installing and Activating Pocket LABEL MATRIX
1 Connect your Pocket PC device to your host computer.

2 Ensure that an ActiveSync partnership is established 
between them.

3 On the host computer, start the LABEL MATRIX label 
design software.

4 On the Tools menu, click PrintPad/ Pocket PC Config-
uration.

The Pocket LABEL MATRIX dialog box appears.

Figure 1-1  Pocket LABEL MATRIX Configuration

5 Under the Platform options, click Pocket LABEL 
MATRIX and then select your Windows CE/Pocket PC 
device from the Model drop-down list.

If your exact model is not listed, try selecting the generic 
processor type (e.g., StrongARM, MIPS, or SH3) that 
applies to your model.

Note You can click the  button to view information on features 
supported by Pocket LABEL MATRIX. For additional 
information, see the Designing Labels for Pocket LABEL 
MATRIX chapter.
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6 Click the Activate button to access the Pocket LABEL 
MATRIX Activation Manager.

7 A message appears asking if you want to install Pocket 
LABEL MATRIX now. Click Yes.

The Pocket LABEL MATRIX Installation dialog box 
appears.

Figure 1-2  Pocket LABEL MATRIX Installation

8 Select your Windows CE/Pocket PC model from the 
Pocket PC to install drop-down list.

9 Click Install Pocket LABEL MATRIX Now.

The Activation Manager will install Pocket LABEL MATRIX 
on the Windows CE/Pocket PC device.

10 Now start the Pocket LABEL MATRIX application on the 
Windows CE/Pocket PC device. (You must run Pocket 
LABEL MATRIX on the device at least once before you can 
activate the program.)

A message will appear to inform you that Pocket LABEL 
MATRIX will run in demo mode. This is correct because 
you have not yet activated Pocket LABEL MATRIX.
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11 On the host computer, a message appears asking if you 
want to activate Pocket LABEL MATRIX on the connected 
Pocket PC device. Click Yes.

A message will appear to inform you that the device has 
been activated successfully.

12 Restart Pocket LABEL MATRIX on the Windows CE/Pocket 
PC device. 

Pocket LABEL MATRIX will now run in full-function mode.

Removing Pocket LABEL MATRIX from a Windows 
CE/Pocket PC Device

1 Connect your Pocket PC device to your host computer.

2 Ensure that an ActiveSync partnership is established 
between them.

3 On the host computer, start the LABEL MATRIX label 
design software.

4 On the Tools menu, click PrintPad/ Pocket PC Config-
uration.

The Pocket LABEL MATRIX dialog box appears.

5 Click Pocket LABEL MATRIX.

6 Click the Activate button to access the Pocket LABEL 
MATRIX Activation Manager.

7 Click Remove This Device.

The Activation Manager will remove the Pocket LABEL 
MATRIX application from the device.

Note In order to remove a Pocket LABEL MATRIX license from your 
Pocket PC device, you must first connect the device to the host 
computer. If you are unable to connect the device for some 
reason (e.g., it has been damaged, lost, or stolen), you will 
need to contact TEKLYNX Technical Support.
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Pocket LABEL MATRIX Main Menu Options

When you start the Pocket LABEL MATRIX application on your
Windows CE/Pocket PC device, the Main Menu will appear. The
Pocket LABEL MATRIX Main Menu allows you to access all
program functions and configuration settings. 

Figure 1-3  Pocket LABEL MATRIX Main Menu

Overview of Main Menu Options:

• Print Labels: Select a label for printing, enter any vari-
able data required, print labels or send labels to a queue 
for printing at a later time.

• Monitor Command File: Monitor command files for 
changes. When changes appear, the system executes the 
command files and prints the labels automatically.

• Configuration: Set up TCP/IP ports, label download con-
nection, or command file configuration.

• Download Labels: Use a wireless connection to transfer 
selected label files to the Windows CE/Pocket PC device. 
This allows you to receive labels from the host PC without  
needing to have the device docked in its cradle.

Note You can double-click the Pocket LABEL MATRIX text at the 
top of the Main Menu to display Pocket LABEL MATRIX system 
status information.
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Pocket LABEL MATRIX

Setting Up a Label in LABEL MATRIX 

Using the LABEL MATRIX label design software, you can design
labels to meet most any industry specification or compliance
labeling requirements. See the LABEL MATRIX Quick Start
Guide or online Help for information on designing a label. 

The New Label 
Wizard

LABEL MATRIX features a helpful wizard that takes you step by
step through the process of creating a new label design.

Figure 2-1 New Label Wizard

Note
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X To start the New Label Wizard:

• Select the Create a new label option from the program’s 
opening screen.

-OR-

• Select New from the File menu.

-OR-

• Click New on the Standard Toolbar.

Note The settings that are covered by the New Label Wizard are also 
available from the Label Properties tabs, accessible by 
selecting Label Properties from the File menu.

Pocket LABEL MATRIX supports all standard types of label
content, including text, bar codes, graphics and several types
of variable data. The following table summarizes the data
origins supported by Pocket LABEL MATRIX and the limitations
that apply.

Data Origin Description

Constant Information does not change from label to label.

Database
Field is populated by a record in a database file. Limited to 
one database; database must have one key field.

Keyboard Input
The operator is prompted for the information at print time. 
(Pick list functionality not available.)

Counter
Information increments or decrements for each label. 
(Supported only with self-incrementing printers.)

Copy
Information is copied from another image. Limitations 
depend on the type of image copied.

Combination
Use math, logic or string functions and/or combine other 
images on the label. Limitations depend on the type of 
image(s) included in the combined image.

Date/Time
Date/time is retrieved from the device’s system clock when 
a label is printed.

Constant 
Graphics and 
Paragraphs

Supports embedded graphics and constant paragraph 
images.
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The Add Printer 
Wizard

The LABEL MATRIX label design software contains hundreds of
printer drivers for thermal/thermal transfer printers from
many thermal printer manufacturers. These printer drivers are
loaded on your computer when the program is installed.

When setting up a new label, you must select a natively
supported printer in the LABEL MATRIX program. Pocket LABEL
MATRIX prints only to printers that are natively supported by
LABEL MATRIX.

In order to print labels using a natively supported printer, you
must first attach the printer using the Add Printer Wizard.

X To attach a printer using the Add Printer Wizard:

1 On the File menu, click Printer Setup.

The Printer Setup dialog box appears.

2 Click Add.

The Add Printer Wizard appears.

3 Click Next on the wizard’s introductory screen.

The printer make and model selection screen appears.

Figure 2-2 Select Printer Make and Model
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Note The Add Printer Wizard screens can also be accessed within the 
New Label Wizard when creating a new label by clicking the 
Select another printer for this design option on the New 
Label Wizard’s opening screen.

4 Click to clear the Extended Driver-(X) check box so that 
only native drivers are displayed on this screen.

5 Select the manufacturer and model of a natively sup-
ported printer (designated by a “(L)” appearing next to 
the printer name), and click Next.

The alias and port selection screen appears.

Figure 2-3 Specify an Alias and Port

6 In the Alias box, type a name for the printer. This is the 
name that will appear in the printers list on the Printer 
Setup dialog box.

7 Specify the port to which your printer is connected.

8 Click Next.



Designing Labels for Pocket LABEL MATRIX Chapter 2-5

9 If you specified a COM port, a COM port setting screen 
appears. Adjust the COM port settings if necessary 
according to your printer manual specifications. (The COM 

port settings specified here should match the settings on 
your printer.) Click Next.

10 To display printer settings after you exit the wizard, click 
the Change printer setup options check box. (Clear the 
check box to accept the default printer settings.)

11 Click Finish.

X To select a previously added printer in LABEL 
MATRIX:

1 On the File menu, click Printer Setup.

2 Select a natively supported printer (designated by an “(L)” 
appearing next to the printer name), and click OK.
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MATRIX

Pocket LABEL MATRIX offers two options for downloading
labels to the Windows CE/Pocket PC device:

• Standard download (with device in its cradle)

• Network download (for network/wireless connections)

For both types of downloads, all files associated with the label
design (e.g., graphic files, database files, etc.) are
automatically downloaded along with the label files in the
download process.

Standard Download

The standard download procedure is used for most typical
direct label printing applications. With this method you simply
download the labels via LABEL MATRIX with your Windows CE/
Pocket PC device in its cradle, and then LABEL MATRIX uses
ActiveSync to transfer the files to your Windows CE/Pocket PC
device. 

1 In LABEL MATRIX, on the File menu, click Download 
Labels to Pocket LABEL MATRIX.

The Download Label to Pocket LABEL MATRIX dialog 
box appears.

Note
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Figure 3-1  Download Labels to Pocket LABEL MATRIX

2 Click the Select Dir button and specify the directory 
where the labels are saved.

3 To select a single label to download, click on the label 
name and then click Add to move the label to the 
Selected Labels box.

4 To select all labels in the directory, click Add All to move 
all labels to the Selected Labels box. 

5 Once all desired labels appear in the Selected Labels 
box, click Download.

6 Specify the directory in which you want to store the files 
and click OK.

A Data subfolder will be created within the specified direc-
tory. The selected labels and all associated files will be 
optimized for transfer and placed in this Data folder. The 
folder will act as a temporary storage bin for your label 
formats as they are automatically downloaded to your 
Windows CE/Pocket PC device.
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Network Download

Pocket LABEL MATRIX allows you to download label design files
over a wireless network using the Windows Networking
Protocol. This is especially useful in situations where multiple
devices are being used for the same application and printing
the same label.

Note The following steps assume you have already successfully set 
up your Pocket PC device to connect to your network.

1 Using Windows Networking, create a shared folder/drive 
on the server — all labels will be stored in this shared 
folder. (For information on setting up a shared folder or 
drive, refer to Windows Help.)

2 Follow steps 1-5 of the previous Standard Download sec-
tion to select labels for download.

3 When specifying the directory in which you want to store 
the files, select the shared folder you created previously 
and click OK.

The selected labels and all associated files will be opti-
mized for transfer and placed in the specified directory.

4 On the Pocket LABEL MATRIX Main Menu, click Download 
Labels.

The network download settings appear.
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Figure 3-2  Network Download Settings

5 In the Server box, enter the full UNC path of the shared 
folder using the following syntax:

\\PCName\SharedFolderName

6 Enter the user ID and password required to connect to the 
host PC. 

7 Click Login. 

After connecting, all label files in the shared folder will 
appear. 

8 Select the file or files you want to download and click 
Download Now. 

The selected files will be transferred to Pocket LABEL 
MATRIX's Data folder on the Windows CE/Pocket PC.

Removing Labels from the Windows CE/Pocket PC 
Device

To remove previously downloaded labels from your Windows
CE/Pocket PC device, you will need to manually delete them
from the Pocket LABEL MATRIX Data subfolder using Windows
Explorer.
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Printing Labels

Printing Labels through Pocket LABEL MATRIX

Note If you plan to print labels using a wireless TCP/IP connection, 
see the Printing Via a Network or Wireless Connection section 
later in this chapter for information on adding a TCP/IP port in 
Pocket LABEL MATRIX.

1 On the Pocket LABEL MATRIX Main Menu, click Print 
Labels.

The Pocket LABEL MATRIX print settings appear.

Note
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Figure 4-1  Pocket LABEL MATRIX Print Settings

2 At the top of the print settings screen, click the drop-down 
arrow to display a list of all downloaded labels.

3 Select the label to print.

If the label contains variable data fields, the associated 
prompts and field values will appear.

4 For labels containing Keyboard Input images, double-tap 
the prompt for a Keyboard Input image. 

A text box will appear in the row, allowing you to input 
your Keyboard Input value.

5 For labels containing database fields, double-tap the 
prompt for a field that is tied to a database.

The database appears in a grid view.
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Figure 4-2  View Database

Select the key field (the first prompted field) to use for the 
database.

6 In the Quantity box, specify the label quantity to print.

7 From the Port drop-down list, select the port to use for 
printing.

8 Click Print.

Note To print labels through Pocket LABEL MATRIX, you must print 
to a natively supported printer, designated by an (L) appearing 
after the printer name in the LABEL MATRIX program.
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Printing Via a Network or Wireless Connection 

Pocket LABEL MATRIX allows you to print labels to a printer on
your network or take advantage of wireless printing to printers
across the globe using a TCP/IP connection. If you are running
Pocket LABEL MATRIX on a wireless enabled Windows CE/
Pocket PC, all you need is a wireless access point and you can
connect the Windows CE/Pocket PC to the wired network. Once
that connection is made, you will be able to print to any TCP/
IP addressable printer on the network.

In order to set up a network printer to print your labels, you
must first add the TCP/IP ports in Pocket LABEL MATRIX. 

Note The following steps assume you have already successfully set 
up your Pocket PC device to connect to your network and that 
the TCP/IP port is working.

X To add a TCP/IP Port:

1 On the Pocket LABEL MATRIX Main Menu, click Configura-
tion.

The TCP/IP configuration settings appear.

Figure 4-3  Add TCP/IP Port

2 Click Add to display the TCP/IP port settings.
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Figure 4-4  TCP/IP Port Settings

3 In the Name box, type a name for the printer (e.g.,“Ship-
ping Printer” or “Production Printer”). 

The name is used as an alias. If left blank, Pocket LABEL 
MATRIX will assign a name based on the IP address such 
as  “IP_172.20.130.30”.

4 In the IP Address box, type the IP address of the printer 
or print queue.

5 In the Port Number box, type the number of the port 
used by the TCP/IP socket communication. 

In most cases the port number is 9100 or 9600. (Do not 
confuse this with the LPT1 port or COM1 port.)

6 Click OK.

The port will be listed on the TCP/IP Ports screen and will 
now be available for selection when printing.
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Queuing Print Jobs

Pocket LABEL MATRIX can also be used in a batch mode,
allowing you to queue your print jobs for printing at a later
time. 

X To send print jobs to a queue:

1 On the print settings screen, click the Port drop-down 
arrow and select the appropriate output port.

2 Click the Queue print jobs check box. 

Figure 4-5  Queue Print Jobs

3 Click Print to save your print jobs to Pocket LABEL 
MATRIX’s Data folder.

X To print all queued print jobs:

1 Clear the Queue print jobs check box and click Print. 

2 Pocket LABEL MATRIX will display the message, “Do you 
want to send all print jobs now?”. Click Yes.

All queued print jobs will be sent to the selected port 
(Com1 or any selected TCP/IP port).
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Labels Automatically

What is a Command File?

A command file is a simple instruction file that can be used to
print labels automatically. You specify the name of a folder to
be monitored, and the system checks for the existence of a
command file (.cmd file) based on the time interval specified.
When a command file is detected in the folder, the system
processes the command file and prints the labels. All command
files in the monitored folder are deleted after printing.

A command file contains commands that identify the name of
the label, the printer to use, and the label quantity. Variable
data can be provided in the command file, or it may be
provided in a separate data file. A command file is an ASCII
text file that can be created with any text editor. Command
files have a .cmd file extension. A sample Pocket LABEL
MATRIX command file might look like this:

 LABELNAME=Shipping.qdf

 PRINTER="192.168.1.102,9100"

 TEXT1="xxxxxxxxxx"
 TEXT2="yyyyyyyyyy"

 BARCODE1="12345678"

Command files can also be used to pass information generated
by other systems and possibly other computers, including
mainframes or mini-computers. For example, an invoicing
program could pass information into a command file, which
would in turn print a label.

Note



Chapter 5-2 Quick Start Guide

Setting Up a Command File
1 On the Pocket LABEL MATRIX Main Menu, click Configura-

tion, and then click the Command File tab.

The command file setup screen appears.

Figure 5-1 Configure Command File

2 For the Folder to Monitor setting, click the browse  

button to select the path to the folder that will contain the 
command files. 

The Folder to Monitor can be either a local folder on the 
Windows CE/Pocket PC device or a shared folder on the 
network. To set the Folder to Monitor as a path to a 
shared-out folder on the network (e.g., 
\\myhostpc\mydata), manually enter the network path 
(the browse button cannot be used to browse a network 
path). Note: To use a shared-out folder on the network, 
you must have write permissions for that folder.

3 Set the following options as appropriate for your labeling 
application:

Default Port: Default port used for printing if the 
PRINTER command is not given in your command file.
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Timed Interval (in seconds): How often the directory is 
monitored for changes.

Process File By: Determines the order in which files are 
processed.

• Date Time: Processing is based on when the file was 
created (oldest first).

• File Name: Files are processed in alphabetical order.

Backup before deleting (BAK): Saves a backup copy of 
each command file after printing takes place.

Stop processing on error: If an error occurs while print-
ing a label, it will stop the print job and prevent printing 
the remaining labels in the file. For example, a misspelled 
field name will end the print job.

Log error to file: Logs any errors encountered during the 
execution of the command file. The file (named 
CMDFILE.ERR) can be found in the same directory as the 
command file.

4 Click OK to return to the Main Menu.

Writing Command Files

Command File 
Formatting

There are many commands that can be issued in command
files. Follow these guidelines when writing the command file:

• Be careful to include the spaces.

• Using quotation marks (" ") around field names is 
optional, unless you are adding spaces in the fields.

• A semicolon ( ; ) indicates remarks or comment state-
ments; characters that appear after a semi-colon will be 
ignored.

• Command files are NOT case sensitive.

Sequence of 
Commands

The LABELNAME command identifies the name of the label to
print, and must be the first line in any command file. It can,
however, appear multiple times in a command file specifying
different labels to print each time.

The LABELQUANTITY command specifies the number of labels
to print, and should be the last line for each label to be printed
from the command file, since it is the active command. The
label prints when this command is encountered. If omitted,
then only one label will print.
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Command File Commands

LABELNAME

The LABELNAME command identifies the name of the label to
print, and must be the first line in any command file. It can,
however, appear multiple times in a command file specifying
different labels to print each time.

If the same label is being printed more than once in the same
command file, it is not necessary to repeat this command. The
program will reprint the last label with the new data and
quantity.

For Pocket LABEL MATRIX command files, the label name must
match the name of the label file after it has been downloaded.
This means that the label name must be specified using the
short (eight character) file name convention, with or without
the file extension. Give only the label name, NOT the full path
to the file. For example, if you create a label in LABEL MATRIX
named "Acme parts", when downloaded to Pocket LABEL
MATRIX this file name will become "Acmepa~1", and so for the
LABELNAME command you would need to give the following:

LABELNAME=Acmepa~1

FIELD_NAME

For each variable data field (Keyboard Input or database) on
the label, there should be a statement in the command file that
assigns it a value. The value for FIELD_NAME in the command
file must match exactly the name of the field in the label; the
variable data should appear after the equal sign within
quotation marks.

For database key data fields, the name of the key data field on
the label should be the same as its name in the database. If
more than one label is being processed in the same command
file, leaving a field name blank results in the last assigned
value for that name being reused. To leave a field blank, insert
a null character (two quotes with nothing in between, "" ) into
the string. For example:

PART_NUM = "836773” 
COMPANY=""
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PRINTER

The PRINTER command is an optional command that identifies
which printer port to use. If the PRINTER command is omitted,
Pocket LABEL MATRIX will use the default port, defined during
command file setup.

The port can be expressed in any of the following three ways,
depending on your printer/port setup:

• If the printer is on COM1, enter the following:

PRINTER="COM1"

• If the printer is on an IP address and port, enter the IP 
address and port number separated by a comma. For 
example: 

PRINTER="192.168.1.102,9100"

• You can also specify the printer port by giving the port 
name you previously defined on the TCP/IP Ports setup 
screen. Enter the Name exactly as it appears on the TCP/
IP Ports screen. For example:

PRINTER="DMX 4206"

Note Many Pocket PC devices have only a USB port. The procedure 
for configuring USB as COM1 depends on your particular 
Pocket PC model, and may require a special cable and driver. 
See your Pocket PC device documentation for information on 
port configuration.

LABELQUANTITY

The LABELQUANTITY command specifies the number of labels
to print, and should be the last line for each label to be printed
from the command file, since it is the active command. The
label prints when this command is encountered. If omitted,
then only one label will print.

Do not include this command if you are using data files; one
label or group of labels will be printed for each line of data. For
example:

LABELQUANTITY=5
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Monitoring Command Files

Once the command file settings have been configured, you can
begin to monitor the command file folder for changes.

X To monitor command files:

• On the Pocket LABEL MATRIX Main Menu, click Monitor
Command File.

The program will begin to monitor the specified folder for 
changes. When a change occurs, all command files in the 
folder will be executed in order.

Figure 5-2 Monitor Command Files

Pocket LABEL MATRIX’s Monitor Command File screen will 
update to display a log of all processed command files, 
giving the time of processing, file name, and status (OK, 
Waiting, etc.)

X To cancel the monitoring process:

• Click the Stop button on the Monitor Command File screen
to cancel the monitoring process.



Inputting Data Using the Symbol 

A

2800 Pocket PC

If you are using Pocket LABEL MATRIX with a Symbol 2800
Pocket PC, you can take advantage of the built-in bar code
scanner features on the Symbol 2800 Pocket PC. Specifically,
the Scan Barcode button (large yellow button near the top of
the device) on the Symbol 2800 Pocket PC allows you to scan
a bar code and automatically input that data into a variable
field on your label.

X To input variable data using the Scan Barcode button:

1 On the Pocket LABEL MATRIX Main Menu, click Print 
Labels.

2 At the top of the printing dialog, click the drop-down arrow 
to display a list of all downloaded labels.

3 Select the label to print.

The associated variable data prompts and field values will 
appear.

4 In the label's Field Value column, highlight the row into 
which you want to place the scanned data.

5 Press the large yellow Scan Barcode button on the Sym-
bol 2800 Pocket PC.

If the scanner is able to read the bar code data success-
fully, the scanned data will be placed in the highlighted 
variable field. 

Note
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